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QAD Customer Relationship Management
Change Summary

The following table summarizes significant differences between this document and the last
published version.

Date/Version Description Reference

November 2014/6.6.2_Revl Updated the slide notes and added answersto Mastery Questionsin | -
slides.

April 2014/6.6.2 Rebranded for QAD CRM 6.2.2

March 2013/6.6.1 Updated exercises and move them to the end of each chapter -
Moved CRM Security to Chapter 1 Introduction Page 10
Updated information of logging on to training environment Page 17
Updated information on All Profiles Screen Page 35
Moved Exporting Reports from Profiles chapter to Reports and Page 97
Dashboards chapter.

October 2012/6.6 Added a new section on contact synchronization Page 52
Added a new section on activity synchronization Page 69
Added a new section on Customer Visit Reports Management Page 70
Updated steps of sending email Page 66
Added a new section on email synchronization Page 67

June 2012/6.5.1 Rebranded for QADCustomerRel ationshipManagement(CRM) 6.5.1 | -
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About This Course

This section introduced the content and requirements of the Customer Relationship Management
Training.

Course Description
Additional Resources
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Course Description

This course is designed to give participants the knowledge and hands-on experience they need to
use the Sales Management Module in the QAD Customer Relationship Management (QAD CRM)
Application.

The Sales Management Modul e enables organizations to manage sales processes, maintain
customer relationships, and interface customer and sales data with QAD ERP.

Course Objectives

By the end of this class, students will:
« Know how to navigate and use help in QAD CRM.

« Use the Sales Management Modul e to manage your organizations sal es opportunities,
customers, and business contacts efficiently.

 Create and use reportsin QAD CRM.

Audience

The audience for this course includes QAD employees, customers, and partners. Specific organiza
tional roles include the following:

- Sales Representatives, Administrators, and Managers
 Customer Service Representatives

- Consultants

» Power Users

Implementation Team Members

Prerequisites
« An understanding of your organization’'s business processes and customer goals
A working knowledge of your organization’s sales cycle and process
« A basic knowledge of QAD Enterprise Applications, including navigation

Course Credit and Scheduling

QAD CRM Sales Force Automation is atwo (2) day class when delivered asinstructor led in a
classroom environment.

M QAD Questions? Visit community.gad.com
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Virtual Environment Information

Use the hands-on exercises in this book with the latest Customer Relationship Management
(CRM) learning environment. When prompted to log in, specify demo for user ID and gad for
password.

Additional Resources

If you encounter questions on QAD software that are not addressed in this book, several resources
are available. The QAD corporate Web site provides product and company overviews. From the
main site, you can access the QAD Learning or Support site and the QAD Document Library.
Access to some portions of these sites depends on having a registered account.

http://www.qgad.com/

QAD Learning Center

To view availabletraining courses, locations, and materials, use the QAD Learning Center. Choose
Education under the Services tab to access this resource. In the Learning Center, you can reserve a
learning environment if you want to perform self-study and follow atraining guide on your own.

QAD Document Library

To access release notes, user guides, training guides, and installation and conversion guides by
product and release, visit the QAD Document Library. Choose Document Library under the
Support tab. In the QAD Document Library, you can view HTML pages online, print specific
pages, or download a PDF of an entire book.

To find aresource, you can use the navigation tree on the left or use a powerful cross-document
search, which finds all documents with your search terms and lets you refine the search by book
type, product suite or module, and date published.

QAD Support

Support also offers an array of tools depending on your company’s maintenance agreement with
QAD. These tools include the Knowledgebase and QAD Forums, where you can post questions

and search for topics of interest. To access these tools, choose Visit Online Support Center under
the Support tab.

Questions? Visit community.gad.com N QAD
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M QAD Questions? Visit community.gad.com


http://community.qad.com

Chapter 1

Introduction to QAD CRM Sales
Management

This chapter provides an overview of the basic concepts of the QAD CRM Sales Management.
What is CRM?

CRM Benefits

CRM Records

CRM Security

Day in the Life QAD CRM
Master Questions
Wrap-Up



6  Training Guide — Customer Relationship Management (CRM)

Overview

CRM Basics - Overview
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QAD MANUFACTURING

In this chapter, you gain an understanding of the QAD Customer Relationship Management
(CRM) functionality which is a part of QAD Customer Management Strategy.

QAD Customer Management Sol utions run and measure marketing campaigns, manage sales
opportunities through the sales lifecycle, and optimize the order and fulfillment process while
ensuring customer retention by enabling you to anticipate your customer’s needs quickly.

Learning Objectives

By the end of this chapter, you are able to do the following:
« Describe the QAD CRM Application Modules

« List the benefits of using QAD CRM
Describe the main records used in QAD CRM — Prafiles, Contacts, and Opportunities

Contrast how you accomplish your daily customer relationship activities today and how you
can accomplish these same activities using QAD CRM

Describe CRM security

M QAD Questions? Visit community.gad.com
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What is CRM?

CRM Basics — What is CRM?
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CRM isastrategy or approach that allows you to respond to the market place and your customers
quickly and effectively through tracking and managing your sales, marketing, and services
functions easily and effectively.

QAD CRM contains the following modul es that share data:

- Sales Management: Manage details of existing, new, and prospective customers and
opportunities.

- Marketing Management: Build, manage, and analyze marketing campaigns and costs.
« Customer Service: Log and assign customer issues for follow-up throughout the customer
lifecycle.
QAD CRM shared functionality includes:
* QAD/ERP Integration
 Activity and task management (calendars, emails, scheduling)
» Customer communication through letters and collateral
» Analytics — Reports and Dashboards

Questions? Visit community.qad.com M QAD
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CRM Benefits
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360- edgree View of Your Customers

A sound CRM strategy enables your business to be efficient, productive, and responsive to the
demands of your Customers and improve your internal communications. QAD CRM provides a
360-degree view of your customer, integrating prospect, customer, and partner information at
every touch point.

The Value of QAD CRM:

 Improve internal team and department communications

» Lower costs while attracting and retaining customers

» Generate greater customer loyalty

« Increase cross-sell and up-sell successes

Improve sales forecasting

Improve customer responsiveness with access to relevant and timely data

M QAD Questions? Visit community.gad.com
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CRM Records

CRM Basics - Records

Profiles

Contacts

Opportunities

QAD CRM has anumber of recordsthat you can manage. Before you see a demonstration of QAD
CRM, let us discuss the three main records: Profiles, Contacts, and Opportunities.

Profile

» A business that has an association with your organization.
A profile can be a customer, prospect, competitor, or supplier.
 Profiles form the core of QAD CRM - QAD CRM is“profile centric”.

Contact

» Contacts are people who work for a profile.
» You communicate with contacts while conducting business-related activities.

- There can be more than one contact specified for aprofile and a contact can be associated with
multiple profiles.

Opportunity

« An opportunity is abusiness “deal” with stages.
» Opportunities are identified and managed to convert them into actual business sales.

Questions? Visit community.qad.com M QAD
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CRM Security

CRM Basics - Security

CRM secures your data by:
Login Security
Business Units
Teams
Permission Groups

Security in QAD CRM involves the following system features or components:

« Login Security - It is password protected: You are allowed three login attempts. If you have
not entered avalid user 1D after three attempts, the Logon screen closes.

« Business Units: Each user is assigned a business unit which can be a branch office, subsidiary,
or business partner. A user can be assigned to one or more business units and is alowed to
access data for the assigned business unit.

- Teams- A team isagroup within a business unit. Users can be assigned to one or more teams
and are able to access the data of their assigned teams. For example, if you are assigned to the
Northeast Sales Team you are able to view all the sales orders that are entered for your team.

» Permission Groups - Maintained by the System Administrator and control accessto system
objects such as menus, programs, and screens.

The QAD CRM Administrator is responsible for creating and maintaining user profilesin the
system. Thisinformation is discussed here so you have a high-level understanding that your data
and transactions are secure.

M QAD Questions? Visit community.gad.com
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Day in the Life QAD CRM

Scheduling and
tfracking to-do’s &
meetings?

History
Reporting?

Marketing
Campaigns - Do
you know how
much they cost?
How do you
manage?

ustomer Service:
Can you easily
determine if your
customer has
reported a problem?

Aswe view either a pre-recorded demonstration of QAD CRM or your instructor demonstrates
QAD CRM, think about the following questions:

« What do the QAD CRM benefits discussed earlier really mean?
« Can you easily respond to the questions in the slide?

« How can QAD CRM change your day-to-day life and improve your organization’s
relationships with your customers?

 Think about your role: Sales, Customer Service, or Marketing how could QAD CRM make
you more productive and help you help your customers.

« If you are a Manager, how can QAD CRM help you manage and motivate your team?

Questions? Visit community.qad.com M QAD
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Master Questions

Master Questions

1

List the three applications that make up QAD CRM:

A profile can be a customer, prospect, competitor, or supplier. (True or False?)
A contact isan individual that works for a profile. (True or False?)

List two benefits of CRM QAD:

An opportunity is a closed business deal or order. (True or False?)

QAD CRM alows login attempts. After incorrect attempts QAD CRM shuts
down.
QAD CRM hasthe following security: login, business unit, , and

permission group. (Fill in the blank.)

M QAD Questions? Visit community.gad.com
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Wrap-Up

Wrap-Up
Review the Chapter Key Points

Questionse

M QAD

« CRM is an approach to understand customer requirements and behavior.
« CRM includes studying sales and marketing effectiveness and market trends.

« CRM requires a customer-centric business philosophy to support effective marketing, sales,
and service processes.

« QAD CRM isthetool that allows you to implement your customer-centric strategy using the
following modules:

» Sales Force Automation
» Marketing Automation
 Customer Service
« CRM/ERP Integration
+ QAD CRM modules share customer data which can be integrated with QAD ERP
« There are many recordsin QAD CRM but the three main records are:
 Profile: abusinessthat has an association with your organization
» Contacts: people who work for a profile
» Opportunity: abusiness lead/deal.
= Your information is securein QAD CRM but can also be shared by business unit and teams.

Questions? Visit community.qad.com M QAD
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M QAD Questions? Visit community.gad.com
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Chapter 2

Getting Started

This chapter providesinformation on the features of the QAD CRM user interface and how to
navigate in the system.

Overview

Access and Exit
User Interface
Help System
Reviewing Settings
Master Questions
Wrap-Up

Exercise
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Overview
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QAD Customer Relatic
Management

In this chapter, you learn how to access, navigate, and use help in QAD CRM. You can review and
change your QAD CRM settings and gain an understanding of QAD CRM data security.

Learning Objectives

By the end of this chapter, you are able to do the following
» Loginand out of QAD CRM.
- Navigate QAD CRM.
» Use QAD CRM help.
» Review your settings

M QAD Questions? Visit community.gad.com
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Access and Exit

Getting Started - Logging in and Logging out
n [ngﬂn QAD CRM
FIQAD
CRM
User ID: ‘
Application Languaga; EENGLISH ivl
QK ] [ Cancel ]
Shut Down QAD CRM
FRIQAD
CRM
What do you want the GAD CRM ko do?
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i
Restart QAD CRM l = j [W]
M QAD :

Logging in to CRM

Depending on the version, QAD CRM can be accessed as a stand-alone database (no QAD ERP
integration), integrated with QAD ERP Standard or Enterprise Edition using the QAD client, or
QAD Remote Sales.

Tologinto CRM:
1 Follow your instructor’s direction to access the CRM login screen

2 Inthe QAD CRM login screen, enter the User ID and Password.
» User ID: demo
» Password: gad

3 Choose an application language.
In the training environment, the Application Language field is set to English, by default.
However, QAD CRM does support multiple languages.

4 Select USA Division (10USA) as the workspace to log on and click OK.

Note The succeeding exercisesin this Training Guide are basing on the data of USA Division
(10USA) workspace.

Questions? Visit community.qad.com M QAD
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Logging out of CRM

1 Select the File|Exit option from the Main Menu.
The Shut Down dialogue box displays.

2 Select Close, Log off, or Restart from the drop-down list and click OK.

M QAD Questions? Visit community.gad.com
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User Interface

Getling Started - Navigating Ul
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The screen has a user-friendly interface that includes the following components:
 Application Menu Bar

The menus provide options for you to perform tasks on CRM, customize the view display, and
access help.

» Application Toolbar

Thetoolbar contains shortcuts to tasks, which are module-specific. You can customize the
buttons to display using the context menu or the View menu on Application Menu Bar.

» Workspace

Typically the workspace has two parts. The top half isabrowser displaying data records for
the selected module. The bottom half displays the selected record details in edit mode.

« Sidebar menu

All system menus are listed herein functional modules. You can hide or display the menu
pane using View menu on Application Menu bar.

- QAD CRM Bar

QAD CRM Bar contains shortcuts of menus that you add to favorites. You can hide or display
this bar using View menu on Application Menu Bar.

- Status Bar

Questions? Visit community.qad.com M QAD
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The status bar at the bottom of the screen displays the company, user, user time zone, node
name and type, client type, date, time, number of selected records, and software version.

M QAD Questions? Visit community.gad.com
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Help System

Getting Started - Accessing Help System
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Integration with QAD
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M QAD

Accessing Help System

To access the help system, do any of the following:
» Press F1 on your keyboard.
+ From the Application Menu Bar, click Help|QAD CRM Help.

« Inthetext box at the upper-right corner of the window, enter a specific question and press
Enter. The relevant help file for your question opensin a separate window.

- |If available, click Help on the Application Toolbar.

Printing Help Topics

You can print help topics. Here is an example of printing all information about Profiles and
Contacts:

1 Fromthe Application Menu Bar, click Help|QAD CRM Help.
The Help system displays.

2 Click Working with Profiles and Contacts in the sidebar menu.
The Help content displays in the workspace.

Questions? Visit community.qad.com M QAD
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3 Click Print at the top of the page.

The Print Topics dialog box displays.
4 Select the option you need and click OK.

M QAD Questions? Visit community.gad.com
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Reviewing Settings

Getling Started - Reviewing Settings
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A QAD CRM System Administrator is responsible for setting up CRM users. This setup includes
associating a user with a business unit, permission groups, mail server, language, initial password,
holidays, teams, and other information.

As auser, you have access to view your settings and also to change some of your details. The
extent of your access varies depending on your organization.

For the purposes of this class, we review the system and detail settings Demo. The changesthat we
make will be used in exerciseslater in this class.

Reviewing My Preferences Settings

1 Navigate to Sales Management|My Settings|Preferences.

The Preferences Dialogue Box displays. There are a number of tabs. General, Email, Profile
Find Cursor, Report Settings, Regional Settings, and Exercise Settings.

2 Click “?" intheright-hand corner to access Help.

3 InHep from the Contents Tab, navigate to Defining Preferences and Settings|Setting General
Preferences and review the description about the settings. Your System Administrator will set
these settings for you.

4 Do not save any changes and click Close to exit.

Questions? Visit community.qad.com M QAD


http://community.qad.com

24 Training Guide — Customer Relationship Management (CRM)

Reviewing My Details Settings

1

5

Navigate to Sales Management|My Settingg|Details. The Details screen displays your personal
details. Always check this screen to make sure that the information is accurate.

Click ?in theright-hand corner to access Help.

In Help from the Contents tab, navigate to Defining Preferences and Settings|Maintaining
Personal Details and review the description about the settings.

Click the Ext/Direct Tel Field. The Phone/Fax dialogue displays. Enter your phone number
and click OK.

Click Save to save and exit.

Important Do not change your password.

M QAD Questions? Visit community.gad.com
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Master Questions

Master Questions

1 QAD CRM supports multiple languages. (True or False?)

2 After selecting arecord, the QAD CRM workspace contains one or more browser windowsin
the upper half of the screen. What is contained in the lower half of the screen?

3 Themenu itemsthat you add to favorites appear as shortcuts on QAD CRM Bar. (True or
False?)

4 You can customize which toolbars to display using View menu. (True or False?)

5 QAD CRM Help can be accessed online and can also be printed. (True or False?)

Questions? Visit community.qad.com M QAD
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Wrap-Up

Wrap-Up
Review the Chapter Key Points

Questionse

M QAD

» QAD CRM and QAD product suite do not share navigation. QAD CRM does not use .NET Ul
Or Process maps.

* QAD CRM supports multiple languages. You are prompted for alanguage during login when
your organization uses more than one language.

+ QAD CRM Ul contains Menu, Workspace, and toolbars. The details information of arecord
that you select in the top part of the Workspace is displayed in edit mode in the bottom part.
You can customize the display of toolbars.

« Helpin QAD CRM iseasy to access online. You can print online help by topic or topic and all
subtopics.

» You are able to review and change your persona details.

M QAD Questions? Visit community.gad.com


http://community.qad.com

Getting Started 27

Exercise

Complete the following hands-on exercise to test your knowledge on changing your personal
details.

1 Go to Sales Management|My Settings|Details.
2 Enter amobile phone number.

3 Enter your work email.

4 Enter your address.

5 Saveyour work.

6 Logoff QAD CRM.

Questions? Visit community.gad.com N QAD
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M QAD Questions? Visit community.gad.com
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Chapter 3

Profiles

This chapter provides an overview of profiles and information on using profiles.
Overview
Profile Types
Searching Profiles
Creating a Favorite
Search Criteria
All Profiles Screen
Filtering Profile Records
Using Profile Filter
Maintaining Filters
Adding a Profile
Master Questions
Wrap-up
Exercise
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Overview

Profiles - Overview
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In this chapter, you gain an understanding of the Profile Record and how to manage your profiles
effectively. The Profiles record forms the core of the QAD CRM system as all contact and
opportunity information is associated with a Profile.

« Profiles either contain or are associated with all the information you need for a 360-degree
view of your business relationship. The information includes addresses, contacts,
opportunities, installed base products, contracts, and more.

- Information is displayed on-line in the following tabs: Details, Further Details, Addresses,
Activities, Opportunities, Relationships, Internal Contacts, Campaigns, Analysis Codes,
Installed Base, Contracts, User-Defined Fields, Attachment, Script, and | ssues.

Learning Objectives
 Describe the Profile Record.
« List the datathat is contained in a Profile.
« Search for aProfile
- Add aProfile

M QAD Questions? Visit community.gad.com
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Profiles - Profile Types
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» A profileisabusiness or business relationship that has an association with your organization.

A profile can be a Customer, Competitor, Partner, Supplier, or any other business or business
relationship that your organization needs to track.

» QAD CRM aso tracks complex business relationships. If your Customer is also a Supplier,

you would designate both types for this profile. QAD CRM supportsthe ability for aProfileto
contain multiple Profile Types.

« Your organization defines the types of business relationships by providing the look-up values
for the Profile Type field.

Questions? Visit community.qad.com
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Searching Profiles
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How many customers, prospects, suppliers, competitors, partners, or other business relationships
are you tracking on QAD CRM? You can track an unlimited number of profiles, however, you
need to access your profiles quickly and efficiently.

QAD CRM provides powerful search facilities to help you locate specific profiles. You can search
for specific profiles/contacts using search criteriaor you can display all your organizations profiles
or profiles based on thefirst letter of the profile name. The two screens that you use to locate your
profiles are:

= Search a Profile or Contact screen
« All Profiles screen.
The navigation and search capabilities of each screen are alittle different, but certain QAD

features apply to most searchesin QAD CRM. For instance, you can generate a report of your
search results, send information to QAD ERP, or export your search from most screens.

M QAD Questions? Visit community.gad.com
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Profiles - Creating a Favorite
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You can access the screens from the CRM Menu or you can create a favorite for the screens that
you frequently use. Favorites appear under Tools in the Application Menu Bar and also in the
QAD CRM Bar (at the bottom of the QAD Menu Bar).

To create afavorite:
1
2
The Add Favorite dialogue box is displayed.
3 Click OK to save.

The Favorite displays:
+ Under Toolsin Application Menu Bar

+ On QAD CRM Bar

Questions? Visit community.qad.com

Navigate to CRM Menu|Sales M anagement|Addresses|Search a Profile or Contact.
Right-click Search a Profile or Contact and click Add to Favorites.
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Search Criteria

Name and Location
Profie Name:
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Type:

Contact
Date
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Profiles - Search Criteria
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You can perform a search based on any of the available criterias. Click a Search Criteriato display
the detailed options. The system searches based on information entered in the expanded or selected

Search Criteria Tab. Information entered into other tabs is not taken into account.

Table 3.1
Search Criteria

Search Criteria

Search by

Name and Location

Profile or alias, name, address, town/city, county, state, post code,
country, profile type

Contact Name details, position description, mail groups

Date Date range will display all records created or modified during the
selected period. You can choose profiles or contacts and search by
creation or modification dates.

Freeform Profile, Contact, Site Address, or Transaction History Fields using a

condition

Profile History Text

Keyword or phrase

Site Address

Any or all of thefollowing fields: Profile Name, site address, town/city,
county, state, post code, and country

MQAD
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All Profiles Screen

Profiles - All Profiles Screen
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The All Profiles Screen accesses dll the Profiles and Contacts in the database. The screen has three
parts: Profile Browser, Contact Browser, and Profile Record Detail.

Profile Browser
» Containsalist of Profiles based on the filter you select (see Filtering Profile Records).

Contact Browser
- Displays all Contacts for the selected Profile in the Profile Browser.

Profile Record Detail
- Displaysthe details for the selected Profile in the Profile Browser in edit mode.

Questions? Visit community.qgad.com M QAD
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Filtering Profile Records
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Using Profile Filter

By default, the All Profiles Screen displays al the profile records in the system. You can
customize the display using thefilters.

To filter the profile records:
1 Locate the Filter on the Application Toolbar.
2 Expand thefilter list and select the filter you need.

Filter |N0 Filter

Mo Filter

Customers

Customers in East Hanawver
Endusers

Prospects

Prospects created this manth
Suppliers

Maintaining Filters

You can create and edit the filters as you need in the Profile Filter window.

1 Click the Filter icon (/== ) on the Application Toolbar.
The Profile Filter window displays.

M QAD Questions? Visit community.gad.com
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2 Do oneof the following:
« To create afilter, Click Add and enter the filter name and other details.

- To edit an existing filter, select afilter and change the details as you need on the bottom
part of the Profile Filter window.

3 Click Saveto save your changes and then click Close to close the window.

Questions? Visit community.gad.com N QAD
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Adding a Profile

Profiles - Adding a Profile
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There are multiple waysto add a profile:
- The Add aProfile option on the Application Toolbar

» Quick Profile: displaysthe Add Profile screen where you can record some basic details for
anew profile.

» Detailed Profile: displays the Profile Add Wizard.
» The Add option in the context menu on Profile Browser
» The Add option in the File menu

Warning

» Do not add duplicate Profiles. Search first! Always Search to ensure that you are not adding
duplicate data.

» QAD CRM issues awarning message if the Profile has the same Name and Postal Code.
Profiles with the same Name and a different Postal Code are not considered duplicates.

» QAD CRM does not stop you from adding duplicate data - be careful.
» QAD CRM is not case-sensitive. enter datathat can be used in letters and memos.

M QAD Questions? Visit community.gad.com
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Master Questions

Master Questions

1  QAD CRM isProfile Centric which meansthat all informationin QAD CRM must be
associated with a Profile. (True or False?)

2 List four Profile Tabs and two data elements in each tab:
Example: Opportunity Tab - Stage Date, Sales Person

3 Profile Name and make a Profile unique.

4 If you do not locate a Profile using the Search a Profile or Contact Screen you are prompted to:
a AddaNew Profile
b Try again with different search criteria

¢ TheProfile closest to your search criteriais returned

Questions? Visit community.qad.com M QAD
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10

Your system administrator can help you enter fields in the correct format by defining the field
style. You can choose the button to the left of the field and a dialogue box will open in the
correct style for you to enter the field information. Name afield that is set up thisway in the
QAD CRM Training environment:

When you add a Profile, QAD CRM will also add a generic Contact if you do not add a
Contact. (True or False?)

Favorites are created in two places: Application Tool Bar and the

QAD CRM isnot case-sensitive. Why is it important to be case consistent and have data entry
standards when entering Profilesin QAD CRM?

Filters can be created and stored for future use. (True or False?)

The All Profiles Screen displays the following windows: Profile Browser, Contact Browser
and the

M QAD Questions? Visit community.gad.com
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Wrap-up

Wrap-Up
Review the Chapter Key Points

Questionse

M QAD

» The Profile Record is the center of QAD CRM. All datain QAD CRM is associated with a
Profile.

There are two search screens:

» Search a Profile or Contact

» All Profiles Screen
» Always Search for a Profile BEFORE adding!
» Do not add duplicate data.

» QAD CRM gives you a duplicate Profile message when you try to add a Profile/Postal
Code combination that exists.

The Profile Nameis the only required field in the Profile Record.

A Profile can be a Supplier and a Customer - complex business relationships are maintained
using multiple profile types.

You can send new Profilesto QAD ERP.

Questions? Visit community.qad.com M QAD
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Exercise

Task 1. Add Search a Profile or Contact Screen to your Favorite list.

1 Navigateto Sale Management|Addresses.
2 Right-click Search a Profile or Contact and choose Add to Favorites.

3 Inthe Add Favorite box, keep the default description and the default folder where the Favorite
item is stored.

4 Click OK.
5 Check whether it appears on QAD CRM Bar and in the Tools menu on Application Menu Bar.

Task 2. Search for all customer profiles based in Sydney.

1 Usethe Favorite you created in Task 1 to open the Search a Profile or Contact Screen.
2 Usethe Name and Location search criteria to define your search options.
3 Inthe Town/City field, enter Sydney or use the look-up icon.

4 Inthe Typefield, click the look-up icon and review the types and select Customer. Note that
you could select more than one Profile Type.

5 Click the Search Button at the bottom of the Search Criteria Tab.
6 All Customer Profileslocated in Sydney are returned to the workspace.

7 You can review the details of a specific profile by highlighting the profile, right-clicking, and
choosing Profile from the context menu.

If the search does not return any records, you are prompted to create a Profile.

Task 3. Create a Profile Filter and use it as the default filter to display all profiles in the State of
California.

1 Navigateto Sales Management|Addresses|All Profiles.

2 Goto View|Toolbars and check whether the Filter option is selected. If not, select it.

The Filter Toolbar displays two objects - the Filter Drop-down list with previously created
filters and the Profile Filter Screen Button that displays a dialogue box where you can cresate,
edit, or deletefilters.

3 Click the Filter Drop-down list and set it to No Filter.
The Profile Browser displays all Profiles.

Notice that the Profiles are not sorted in any particular order. To sort by Profile Name, Click
the Profile Name Label. The Profile Browser sorts al Profiles by Profile Name.

4 Click the Filter button to display the Profile Filter screen.
5 To create aFilter, click the Add Button in the lower right-hand corner of the screen.

6 Enter Cdiforniain the Filter Namefield.

M QAD Questions? Visit community.gad.com
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7 Select the Default Filter Check Box to make it the default view of the All Profiles Screen.

8 Inthe State field, use the look-up icon to put CA-California, US into the Selected States
column and click OK.

9 When you return to the Profile Filter Screen, Click Save & Close to close the screen and save
your work.

10 TheCaliforniaFilter istriggered when you saved your work. The Profile Browser displays all
Profiles from California

Note To learn more about the Profile Filter Screen go to Help|Working with Profiles and
Contacts|Filtering Profile Records.

Task 4. Create a Profile using the given information.
« Company Name: Boulder Industries
 Address: 1500 28th Street, Boulder CO 80303
 Contact: None Given
« Company Size: Around 400 Employees Worldwide - 2 million in revenues
» Business: Distribution

1 Search First! Navigate to the Search a Profile or Contact Screen.

2 Profile Name = Boulder Industries.

3 Click the Search Buitton.

4 Boulder Industries profileisnot in QAD CRM. You are prompted to add a profile.
5 Click Yes.

6 Profile Add Wizard -Details Tab is displayed. The Profile Name field is auto filled based on
your search criteria. The label isin red indicating arequired field.

7 DetailsInformation: If there is a button next to the field |abel, select the button rather than
entering free-form information. If your system administrator has defined afield style, clicking
the button opens a dialog box which reflects the defined style. If thereis alook-up icon, use
the look-up to get the exact spelling of avalue.

Enter the Details Information that you know.
« Address = 1500 28th Street, Boulder CO 80303
 Type = Prospect
« Company Size = 2-5 Million
« Employees = 100-499
« Region=US
- Source = Seminar/Conference
8 Further Details: Select Further Details from the sidebar or use the green arrow in the lower
right-hand corner to move to the next tab.
Enter the Further Details Information that you know.
 Ext. Account Manger = Demo (your self)

Questions? Visit community.gad.com N QAD
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10
11

12

13

14

» Time Zone = MST/MDT (Mountain Time)

The Ext/Int Account Manager fields can be pre-populated through the Territory Management
Module or you can use the Alloc Buttons or Lookup. The Alloc Buttons display the account
managers based on Territory Management assignments. The Lookup Button displays the
names of al Account Managers.

You do not have enough information for the Contacts, Addresses, Analysis Codes, or User-
Defined Codes Tabs at thistime. Leave these tabs empty.

Save your new Profile by clicking OK.
Click Yes when you are prompted to send this new Profile to QAD ERP.

Click OK when QAD CRM notifies you that record is successfully transferred to QAD ERP.
The Profile displays showing all associated tabs such as Campaigns, Opportunities, Installed
Base, Contracts, and Script.

Review the new Profile. A Contact has been added with aLast Name = Sr/Madam as you did
not add a Contact Record for this Profile.

Note Profiles must have at least one Contact. If you do not enter a Contact, the system adds a
generic contact for you.

Click Close to close the window.

M QAD Questions? Visit community.gad.com
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Contacts

This chapter provides an overview of the contacts and information on setting up contacts.
Overview

What information is contained in a Contact?
Searching for a Contact

Adding a Contact

Copying a Contact

Synchronizing Contacts

Master Questions

Wrap-Up

Exercise
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Overview

Contacts - Overview
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In this chapter, you gain an understanding of the Contact Record, how to manage your contacts
effectively, and how the Contact and Profile Records work together. Contacts are people who work
for or are associated with a Profile.

Learning Objectives

By the end of this chapter, you will be able to do the following:
» Describe the Contact Record

List the data that is contained in a Contact Record

Search for a Contact

Add a Contact

Synchronize contacts with Microsoft Exchange Server

L]

M QAD Questions? Visit community.gad.com


http://community.qad.com

Contacts 47

Contact Persons Screen

ContactPersons Screen
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The Contact Persons submodule is designed for managing details of contact persons. Contact
persons, or contacts, are people who work for profile organizations and with whom you
communicate to conduct business-related activities. There can be more than one contact person

specified for a profile organization. Also, one contact person can be associated with multiple
profiles.

Pay attention to the following points on a Contact:
A Contact is a person who is associated with one or more Profiles.

It isimportant to remember that Contacts are people vs. organizations. Those business
activities that need interaction with a person should be associated with a Profile and a Contact.

Your organization maintains relationships with Profiles through Contacts.

Internal Contacts are people who work for your organization and have an association with a
Profile. Internal Contacts are added and maintained using the Internal Contact Tab on a
Profile. Internal Contacts must be in the User File.

What information is contained in a Contact?

» Contact Records contain amixture of personal and businessinformation. Personal information
includes how to best communicate with the individual as well as information that includes
their hobbies and family members.
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- Information is displayed on-line in the following tabs: Details, Further Details, Activities,
Mailing List, Activities, Relationships, Campaigns, User-Defined Fields, Attachments, and
Scripts.
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Searching for a Contact

Searc hing for a Contact
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QAD CRM provides the same search facilities to help you locate specific Contact Records that
you used earlier to search for Profile Records. You can search directly for the Contact Record or
you can search for the Profile that the Contact is associated with. The two screensyou useto locate
your contacts are:

» Search a Profile or Contact Screen
» Contact Persons Screen.
You aready know how to use the Search Profile or Contact Screen and the All Profiles Screen

from the Profile Chapter. Navigation in the Contact Persons Screen is similar to the All Profiles
Screen.
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Adding a Contact

Adding a Contact
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There are a number of waysto add a Contact to a Profile. Remember that a Contact is associated

with a Profile. Typically, you would add a Contact at the time you add the Profile or you can
update the Profile with additional Contacts later.

The slide displays adding a Contact by right-clicking in the Contact Browser from the Contact

Persons Screen.

Warning

» QAD CRM dlowsyou to add duplicate Contacts. A Contact can be associated with more than

one Profile.

« For instance, a Contact can be the owner of one company and a consultant at another. Both
organi zations are your customers, so you want to track both contact relationships.

 Be cautious when adding duplicate Contacts, ensure that your actions make sense. Sear ch
First! - before you add Contacts.

- Beaware of your organization’'s data entry standards. Make sure that the Contact fields are
cameraready and can be used in letters, emails, and other public facing documents.

MQAD
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Copying a Contact

Copying a Contact
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You can copy acontact record and associate it with another profile apart from the current one. This
function is useful when most information for the existing contact and the new contact is the same.

1 Select the contact record and click the Copy Details button on the toolbar. Alternatively, select
Copy Details from the File menu, or right-click and select Copy Details from the context
menu. The Copy Contact pop-up displays.

2 Click the Select Profile button. The Find Profile/Contact window opens.

3 Search for the profile with which you want to associate the new contact record you are
creating, and click OK. This operation attaches the contact record to the selected profile.
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Synchronizing Contacts

Synchronizing Contacts

QAD CRM

Contacts

Microsoft Outlook

M QAD

You can synchronize the contacts with Microsoft Outlook in QAD CRM if the Exchange Server
settings are properly configured and you are authorized by the system administrator.

The contacts information can be synchronized in bi-directional manner either manually or
automatically depending on the synchronization policies.

Synchronizing Microsoft Outlook contacts to QAD CRM

If the Transfer Mode is set to Automatic, the contacts created in QAD CRM are automatically
transferred to the Microsoft Outlook contact list after synchronization. If the Transfer Mode is set
to Manual, manually send the contacts to the exchange server.

To manually synchronize contacts:

1 Select the contacts to synchronize in the Contact Persons window.
Note You can use the Contact Filter to filter out all the contact that you want to synchronize.

2 Right-click the selected contacts and choose Send to Exchange Server from the menu.

The contacts will be transferred to Microsoft Outlook until the next synchronizationis
performed.
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Synchronizing Microsoft Outlook contacts to QAD CRM

If your system is configured to synchronize data categorized as QADCRM, create a QADCRM
category first.

To synchronize contacts:
1 Create acontact or select an existing contact in Microsoft Outlook.

2  Categorize the contact as QADCRM. It depends on the system settings by the system
administrator.

3 Savethe contact.
The contacts will be synchronized to QAD CRM until the next synchronization is performed.
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Master Questions

Master Questions

1

2

A Contact is a person that can be associated with more than one Profile (True or False?).

An Internal Contact is associated with and maintained from the Tab on the
Record.

An easy way to associate a Contact with another Profile isto use the Copy Details Option
(True or False?).

List four Contact Data fields with field descriptions, and the Contact Tab where they are
displayed:

Example: Field: Source, Description: Where did we hear about this Contact? Tab: Further
Details

Last Name, First Name, Contact Name, Position, and Mail Groups are all Search Fields on the
Search for Profile or Contact Screen (True or False?).
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Wrap-Up

Wrap-Up
Review the Chapter Key Points

Questionse

M QAD

» A Contact is a person who must be associated with a Profile.

« A Contact can be associated with more than one Profile. An example is a Contact who works
for one Profile and is a consultant to another.

» There are two search screens:
» Search a Profile or Contact
» Contact Persons Screen

» Always search before adding data, such as Contact Records and Profile Records. Itis
important in tracking earlier relationships with a Contact.
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Exercise

Task 1. Search for the contact record of Justin Kidman.

1 Navigate to the Search a Profile or Contact Screen.
2 Expand the Contact criteria.
3 Enter Kidman in the Last Name Field.

4 Click the Search Button.
The Contact Record for Justin Kidman displays.

5 To open the contact, right-click the record and choose Contact from the context menu.
The contact details for Justin Kidman are displayed.

Note If you choose the Profile option from the context menu, the related Profile would open. You
can also see the contact details by double-clicking the contact record of Justin Kidman.

Task 2. Try the following alternative to search for the contact record of Justin Kidman.

1 Open the Contact Persons Screen and ensure that there are no active filters.

2 Click the Search button on the Application Menu Bar.
A Search Bar appears on the top of the Contact Browser.

3 Select or enter the following values and click Search Now:
« Search field = Contact Name
 Condition field = begins
« Value=J
All contact records with the contact name started with J are displayed.
4 Scroll thelist to find the record of Justin Kidman.

5 Select the record of Justin Kidman.
The details are displayed in edit mode.

Note You can aso use the Search button to search for data records in any browser where the
button is available.

Task 3. Use the following scenario to add a contact to an existing profile.

While visiting the Heron Surgical Supply, your main contact, Donald Schneider, introduces you to
the manager Mark Flynn. Add Mark as a Contact associated with the Heron Surgical Supply.
There are a number of waysto do so. Let us add the new Contact from the All Profiles Screen.

1 Searchfirst to seeif Mark Flynn exists.
2 Display Heron Surgical Supply in the All Profiles Screen.
3 Right-click in the Contact Browser and choose Add Contact from the context menu.

4 The Contact Details window displays. The Profile Addressfield is pre-filled.
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5 Add the email address and phone (use your own email address and phone number). Use the
buttons next to the fields to take advantage of any field styles that can be predefined and use
the look-ups to choose the correct information. Save your work.

6 Now we have enough information to indicate that Donald Schneider reports to Mark Flynn.
Right-click Donald Schneider in the Contact Browser and choose Edit Contact.

7 Click the Further Details Tab and locate the Reports To field. Using the look-up icon, select
Mark Flynn. Save the record.

Task 4. Copy the Mark Flynn to the profile of Boulder Industries that you created in the exercise of
Profiles.

1 Goto the Contact Persons Screen and locate the record of Mark Flynn.
2 Select Mark Flynn and click Copy Details button on the Application Toolbar.

3 Onthe Copy Contact box, click Select Profile button.
The Find Profile/Contact screen appears.

4 Enter Boulder Industriesin the Profile Name field and click Search.
5 Select Boulder Industries and click OK.
6 Onthe Copy Contact box, click OK.

7 Goto All Profiles screen and check if the record of Mark Flynn is associated with Boulder
Industries.
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Chapter 5
Activities

This chapter provides an overview of managing activities. It then covers the management of
business-related Activities, Tasks, Emails, and Letters.

Overview

Activity Calendar

Accessing Activities and Tasks
Adding Activities

Processing an Activity

Task Management

Adding a Task

Emails - Letters - Contact Notes
Sending Email from QAD CRM
Synchronizing Emails

Sending a Letter

Making a Note

Synchronizing Activities
Managing Customer Visit Reports
Master Questions

Wrap-Up

Exercise
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Overview

Activities and Tasks - Overview

Ernail Letter

Activities are business-related.
Tasks are non-business related activities.

In this chapter you learn how to communicate with your Profiles, Contacts and Internal Contacts
using Exercise — Managing Opportunities Activities, Tasks, Emails, and Lettersin QAD CRM.

The QAD Customer Relationship Management (QAD CRM) Application describes Activities as
business-related activities and Tasks as “to-do’s’ that you can assign to yourself or others. You
can schedule both for a particular date, but Activities such as Appointment and Telephone also
have due time. Tasks have a due date but not atime.

Learning Objectives

By the end of this chapter, you will be able to do the following
- Describe Activities and Tasks.

List the Activity Types.

Add and process an Activity.

Add a Task.

Synchronize Activities and Tasks

Describe a Contact Note.

Explain how to send Email.

Synchronize Emails.

Explain how to send a L etter.

L]

L]
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Activity Calendar

Activity Calendar
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Accessing Activities and Tasks

The Activities Module ensures that your sales and marketing teams always have the relevant
customer, market, and sales information at their fingertips. This moduleis available in both Sales
Management and Marketing Management: Main Menu|Sales Management|Activities or Main
Menu|Marketing Management|Activities.

When you choose Activities from the application menu, the Activities calendar displaysin the | eft
portion of the workspace. The calendar display is defined by the view you select - Day, Week,
Work Week, Month, or All.

The Task Areais not displayed in the All View. The All View displays al activity records,
irrespective of the day, week, and month in alist that can be filtered as there can be a great many
records.

To further clarify your results, the All View also utilizes a strike through format for those activities
that have already been processed and activities are color coded according to the default settings.
For instance, red color indicates overdue activities. Blue color isfor high-priority activities.

Note The All View does not display the Task Areaor the calendar.

You can integrate the QAD CRM Calendar with Microsoft Outlook. Integration with Lotus Notes
is scheduled for afuture release.
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Adding Activities

Adding an Activity
Adding an Activity from:
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There are many ways to add an activity including:
- Right-click in the Activity Tab Window from the Profile, Contact, or Opportunity Records.
« Right-click in the Calendar from the Activity Module.
» Use the Add an Activity from the QAD CRM Toolbar.

The Activity Type Dropdown displays alist of activity types: Telephone, Appointment, Letter,
Email, or Script.

The Telephone and Appointment types appear in al of the Calendar Views and the Activity Tab
on the Profile, Contact, and Opportunity Records. The Letter and Email types appear on the All
View in the Calendar and the Activity Tab for the Profile, Contact, and Opportunity Records.
Scripts have their own tab on the Profile and Contacts Records.

Note We discuss Scriptsin alater chapter.
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Processing an Activity
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After creating atelephone or appointment activity, you are required to processit either on or
before the scheduled date. When you process an activity, you document what happened and next

steps. You can even create a follow-up activity. When you process activities, you create

transaction history records.

Questions? Visit community.qad.com
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Task Management

Task Management
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Indude Tasks With No Due Dates

Tasks are “to-do’s” that you can assign to yourself or to othersin your team through the Activities
Module. Tasks assigned to you display in the Task Areaon the Activities Calendar. Tasks assigned
to others display on their Activities Calendar. You can view all Tasks you created by selecting the
correct Task View.

Tasks records have different views. Right-click the Task Areato select the required view from the
options.

You can select the number of Tasks you want to display using the Options button available just
below the Tasks areain the workspace.

You close a Task by selecting the check box next to it. Closed Tasks are displayed with strike-
through text.

You can associate a Task with a Profile, Contact, Opportunity, Campaign, Installed Base, or Issue.
When you associate a Task to arecord, you are allowed to open the associated record from the
Task. The Task does not appear on the record.

Note Task Email Reminders functionality is disabled in the training environment. But you can
useit if your production environment is integrated with Microsoft Outlook.
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Adding a Task
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To add atask:
1 Openthe Activities Screen.

2 Right-click in the Task Area and choose Add from the context menu.

The Task Details window displays.

3 Enter thetask information. You can add associated profiles, contacts, or events using the

Associate with button.

4  Click Save and then close the window.

Questions? Visit community.qad.com
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Emails - Letters - Contact Notes

.
Emails — Letters — Contact Notes
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QAD CRM support many different methods of communication. We have learned how to add
activitiesto our calendars and create tasks for ourselves and other team members. We can also
send emails and letters using templates or attach anote to a Profile/Contact to add information that
might not be associated with a communication event.

Sending Email from QAD CRM

You can compose and send emailsin QAD CRM system when the Exchange Server is enabled and
the email preferences are configured properly in your system.

When you send email through the Activities module, it automatically gets included in the Profile
Transaction History. When you send email using the Send Email button, you request that the email
is saved in the selected Profile transaction history.

To send email from QAD CRM:

1 Do any of thefollowing:
« Click the Send Email button on the tool bar.
+ Choose Email from the Add an Activity drop-down list.

2 If the Select Compose Screen pops up, select your email client and click OK.

M QAD Questions? Visit community.gad.com
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Select Compose Screen

[Z1x]

V¥ always Ask when Composing an Email
Select Default Compose Screen

 MS Outlook

" GAD CRM

1+ Defaulk Email Client

OK Close

3 Compose and send your email.
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Either you use QAD CRM or M S Outlook as an email composer, you can choose a pre-defined

template to compose your email.

Synchronizing Emails

You can synchronize emails in QAD CRM system if the integration with exchange server is
enabled by the system administrator. The synchronization could be performed in either of the two

ways:

« Automatically. If the automatic email synchronization is enabled, the emails will be

Questions? Visit community.gad.com

synchronized automatically when the Admin Service checks for new emails.

Note The emailsfrom Microsoft Outlook are reconciled by the email addressin QAD CRM.
If the email address matches that of a contact in QAD CRM, the email details are created asa
history record in QAD CRM against that profile and contact.

Manually. If the automatic email synchronization is not enabled, you need to do it manually.

If you use Microsoft Outlook and Outlook Access, copy the email from a CRM contact to the
QAD CRM History folder using the Copy to Folder option. The email will be brought into
QAD CRM when the Admin Service checks for new emails.
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You can also synchronize an email from any mobile clients by forwarding the email from a
CRM contact to the QAD Mail Room Address. In the Subject filed of the forwarded email,
include the email address of the original email sender and the original subject. Use a pipe
character (]) to separate the email address and the subject.

Example
Original Subject: Re: Quotation
Subject in the forwarded email: username@company.com| Re: Quotation

Note You can get QAD Mail Room Address at the Emails tab in Settings|Mail Server
I ntegration|Settings and Switches.

MNQAD
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Sending a Letter

Similar to email communications you can generate aletter as an Activity or by using the Send a
Letter button in the toolbar. When you create a letter in QAD CRM, you create a Microsoft Word
document (.doc) based on atemplate. The template includes the required format and fields that are
merged with the information from the selected CRM record.

L etters created through the Send a L etter button are generated immediately. L etters created as
Activities are generated only when they are processed based on their scheduled dates.

Making a Note

The Make a Note button from the tool bar gives you the ability to add information to the
Transaction History for a Profile/Contact. Once you make a note and save it, you can view it from
the Profiles module in Activities/History.

Notes can include comments, imported files, or attachments.

Note Refer to QAD Online Help or the QAD Customer Relationship User Guide for more
information on Notes.

M QAD Questions? Visit community.gad.com
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Synchronizing Activities
Appointments and tasks can be synchronized between QAD CRM and Microsoft Outlook in both
directions depending on the synchronizing policies by the system administrator.

To create an activity (appointment, meeting, or task) in Microsoft Outlook and synchronize it to
QAD CRM:

1 InMicrosoft Outlook, create an activity (appointment or task) as you normally do in Outlook.

2 Categorize the activity as QADCRM. It depends on the system settings by the system
administrator.

3 Theactivity will be synchronized to QAD CRM the next time the activity synchronization job
isrun.

Note You can view the job statusin the AdminService job history in QAD CRM.

Questions? Visit community.gad.com N QAD
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Managing Customer Visit Reports

You can compose and submit visit reports from any email client and do not need to log on to the
QAD CRM system.

To submit areport using email:

1

2

4

5

From your email client, create an email.

In the recipient field, enter the QAD CRM Mail Room Address.

The system administrator maintains QAD CRM Mail Room Address on the Email tab in
Settings|Mail Server Integration|Settings And Switches.

Include the title of your report followed by the email address of the contact who you visited.
Use a hyphen to connect the title and the email address.

Example Subject: Customer Visit Report - username@company.com
In the email body, compose your report content.

Send the email when you finish.

When the email is sent, the visit report details will be attached to the Profile. The authorized users
can access the report details from the Activities tab in the All Profiles module.

M QAD Questions? Visit community.gad.com
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Master Questions

Master Questions

1

How do you add a Task?

a Right-click in the Task Arealocated in the CRM Calendar.
b Select aProfile and right-click the Profile.

c All of the above.

List two types of Activitiesthat appear on your Calendar.

When you Process an Activity (telephone or appointment), you indicate that the activity is
closed or completed. (True or False?).

Thevaluein the Field for both Tasks and Activities can change the display
color.
When you associate an Activity or Task to a Profile, Contact or Opportunity, the Activity/Task

appear in the associated record. (True or False?)

Questions? Visit community.qad.com M QAD


http://community.qad.com

72  Training Guide — Customer Relationship Management (CRM)

Wrap-Up

Wrap-Up
Review the Chapter Key Points

Questionse

M QAD

- Thefollowing Activity Types are availablein QAD CRM:
Telephone

» Appointment

o Letter

« Email

« Script
Tasks are “to-do’s’ that assign to yourself or to others.

- Some Activities appear on the internal QAD CRM Calendar and can be integrated with
Microsoft Outlook

+ You can associate most activities and tasks to records within QAD CRM for easy navigation
and follow-up.

Activities become part of the Profile/Contact Transaction History.
= You can add Notes to the Transaction History without adding an Activity.

M QAD Questions? Visit community.gad.com
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Exercise

Task 1. Use the following scenario to review your knowledge on how to handle activities and
tasks.

Your customer Donald Schneider at Heron Surgical Supply would like ademonstration of the new
product line. Donald is free next Tuesday from 1:00 p.m. until 3:00 p.m.. Create an appointment
and invite your colleague Tim Michaels to attend.

1 Navigate to the Heron Surgical Supply Profile and select the Activity Tab.

2 Right-click in the Activities Tab and select Add |Appointment.
The Appointment Screen opens to the Appointment Detail Tab.

3 Enter asubject for the appointment.

The Profile, Contact, and Responsible fields are filled. The Contact field contains the default
contact - Donald Schneider. If you wanted another contact, click Select Contact button.

4 Although the Location Field has a drop-down list associated with it, you can also typein a
value. Typein Heron Surgical Supply.

5  Set the scheduling information for this appointment as given in the scenario.
6 Organizer and Priority arefilled in. If necessary, you can also change them.
7 Add the Categories of Key Customer and Strategies for reporting purposes.

8 You could mark this appointment a Private Meeting by selecting the Private checkbox, but for
this meeting that would not be appropriate.

9 Click the Further Details Tab and add Tim Michagls to the attendee list.
10 Click Associate it with button and select Electronic Services Ltd asits associate.

11 Save the appointment. Do NOT notify the attendees now as we are not integrated to a mail
server in this environment. When appointment notification is sent out to internal users, itis
reflected in their activity calendar.

12 View the new appointment in the Activities Calendar, Profile, and Contact. Select the All
Activities View (if the appointment does not appear, select FileRefresh, and try again).

13 Right-click the Appointment in the All View and choose edit to change the priority to A-High.
14 Saveyour work. Notice that the Appointment changes color to blue based on its priority.

Task 2. Use the following scenario to process the appointment activity.

You just returned from the Demonstration with Donald and his team. They were impressed with
the new products and would like you to return next week for another presentation. thistimeto
Donad's manager. Let us set up the new presentation and record our results.

1 Navigateto the Appointment and double-Click to open.

2 Update the Contact Notes and Outcome. Then, select Follow-up Activity to create another
demo.

Questions? Visit community.gad.com N QAD
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3 Edit the appointment information and saveit.

4 Open the appointment and check the appointment history.

Note You can also Process the appointment by right-clicking the appointment, and selecting
Process from the menu. Opening the appointment or right-clicking on the appointment takes you
to the Process Activity Screen.

Task 2. Use the following scenario to create and manage a task.

In reviewing the new product features, you believe some of your customers can benefit from the
new release. There are benefitsin giving one presentation vs. many. Create a Task to review your
accounts and associate the Task with those Customers that should attend the presentation.

1
2

3

Main Menu|Sales Management|Activities.

Choose the Calendar Day View from the Application Toolbar.

The Task Area displaysin the lower right-hand corner. Right-click and choose Add from the
menul.

The Task Detail Screen displays. There arefive (5) required fields: Subject, Responsible, Start
Date, Priority, and Status. Responsible, Start Date, Priority, and Status are pre-popul ated with
default values. Enter the following:

Subject = New Feature Release Review

Responsible = Default (Your User ID). You can assign to another User in thisfield
Due Date = Choose a Future Date

Start Date = Default Today's Date (click the checkbox)

Comments = New Feature - Customer List

Priority = Change to A-High

Status = Change to Open

Associate it With = Heron Surgical Supply

5 Savethe Task. The Task displaysin the color blue asit has a Priority of A-High.

M QAD Questions? Visit community.gad.com
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Chapter 6

Opportunities

This chapter provides an overview of opportunities and how to manage your business
opportunities using QAD CRM

Overview

Opportunities = Business Deals
What information is contained in an Opportunity?
Searching for an Opportunity
Opportunity Filter

Sort Columns

Profile Record - Opportunity Tab
Customer Console

Opportunity Management
Adding an Opportunity
Changing Opportunity Sages
Master Questions

Wrap-Up

Exercise
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Overview

Opportunities - Overview
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In this chapter, you learn how to manage your business opportunities using QAD CRM.
Opportunities begin as business |eads generated by your sales organization and marketing
department.

Learning Objectives

By the end of this chapter, you will be able to do the following
» Describe the Opportunity Record.
List the data that is contained in an Opportunity Record.

» Search for an Opportunity using the Opportunity Screen, Profile Opportunity Tab, or
Customer Console.

Discuss the business opportunity management process stages.
Add an Opportunity.

L]

Maintain an Opportunity.

M QAD Questions? Visit community.gad.com
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Opportunities = Business Deals

Opportunities = Business Deals
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» An Opportunity isabusiness “deal” that managed effectively to turn the prospective “deal” or
lead into an actual sale or order.

- Make sure that you associate Opportunities with a Profile, Contact, and Sales Representative.

- Typically Opportunities are managed through a staged business process which can include:
identifying, follow up, sending quotes/negotiating deals, finalizing orders, and offering post-
sales service.

» QAD CRM supports the staged business process through the values defined in the required
Stage Field: Enquiry, Quote, and Order. QAD CRM also supports user-defined stages. In our
training system, we have added the following stages: Installed base, Invoiced, Lost, and Dead.

What information is contained in an Opportunity?
 Opportunity Records contain information related to the business deal.

« Information is displayed on-line in the following tabs. Details, Further Details, Activities,
Enquiry, Quote, Order, Other Stages, Role Players, Defined Fields, Attachments, and Scripts.

Questions? Visit community.qad.com M QAD
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Searching for an Opportunity

Searching for an Opportunity
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Customer Console

QAD CRM Opportunities are accessed from the Opportunity Screen, the Opportunity Tab in the
associated Profile Record. If CRM/ERP Integration is active and the Opportunity Stageis set to
Quote or Order, you can also access the opportunity screen from the Customer Console. In the
Customer Console, you cannot view the opportunities that are in the Enquiry Stage.

Opportunity Filter

All the Opportunities for your organization are listed in the Opportunity Browser on the
Opportunities Screen. The Opportunity Filter issimilar to Profile Filter and Contact Filter. You
can either use the existing filters or create your own filters to locate a subset of Opportunities.

Sort Columns

You can sort the Opportunities in the Opportunity Browser by clicking the column heading. You
can also change the order or the fields displayed in the Opportunity Browser (as you can with any
record browser) by using the Show Column feature.

Profile Record - Opportunity Tab

Opportunities must be associated with a Profile, Contact, and Sales Representative. The
Opportunity Tab for each Profile hasalist of all Opportunities associated with that Profile. You
can sort and report on the Opportunities from the Opportunity Tab.

M QAD Questions? Visit community.gad.com
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Customer Console

The Customer Console provides an all-around view of a customer record, as the screen displays a
combination of datafrom both QAD ERP and QAD CRM.

The Customer Console can only be used if QAD ERP/CRM Integration is active. In addition,
Opportunities are displayed in the Customer Console depending on the Opportunity Stage field
(Quote Stage or beyond).

Questions? Visit community.gad.com N QAD
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Opportunity Management

Opportunity Management
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Managing business opportunitiesisapart of business generation efforts. Every organization has a
business and selling process to ensure their success. Many of these processes are designed based
on the business sector.

QAD CRM isdesigned to accommodate and enhance your organization’s selling process. You can
manage alist of opportunities, specify opportunity details, identify key people involved in the
opportunity, maintain quotes and orders, and keep a historical record of al customer activities.
Typically the opportunity management process has the following stages.

« ldentifying Opportunities

« Following Up on Opportunities

» Sending Quotes and Negotiating Deals

« Finalizing Orders

- Offering Post-Sales Service.
The Opportunity Stage Field isarequired field. The value of thisfield indicates where the
opportunity is in the management process. The ENQUIRY, QUOTE, and ORDER Stage Values

are required when using QAD CRM. Your organization can also add other stage valuesto help you
manage your Opportunities.
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Adding an Opportunity

Opportunities are identified for new or existing customers. Depending on your organization’s sales
process when an Opportunity for anew customer isidentified it can bereferred to asalead or a
prospect.

It ismost important that you enter any identified Opportunity into QAD CRM so you can manage
and record your actions and progress in turning the Opportunity into an order.
There are multiple ways to add an opportunity:
 On the Opportunities screen, click the Add button on the toolbar.
+ On the Opportunities screen, right-click in the Opportunity Browser and choose Add.
« Onthe All Profiles screen, right-click in the Opportunities tab of a selected profile and choose
Add.
Note Similar options are available for Add, Copy, and Delete.

We go through the detailed tab of Opportunity Details screen in the succeeding exercise. For more
information on each tab of Opportunity Details, see User Guide: Customer Relationship
Management or CRM Online Help.

Changing Opportunity Stages

The standard or fixed stages for a QAD CRM opportunity are:
« Enquiry: It isthe starting point for any opportunity and is mandatory.

 Quote: This stage corresponds to the QAD Enterprise Applications sales quote. It isonly
required if CRM will generate quotations or if sales quotes are used in QAD Enterprise
Applications and visibility of those quotesis required in QAD CRM. You can print the quote
from QAD CRM.

« Order: This stage corresponds to the QAD Enterprise Applications sales order. It is only
required if CRM needs to create sales ordersin Enterprise Applications or if visibility of sales
orders created in QAD Enterprise Applicationsis required in QAD CRM.

- Invoiced: This stage correspondsto an order in Enterprise Applications asinvoiced. When the
sales order corresponding to a CRM opportunity isfully invoiced in Enterprise Applications,
the stage of the opportunity is set to Invoiced.

An opportunity isinitiated with the status of Enquiry. During your follow-up activities, you change
the opportunity stages due to the progress of communication between you and your customer. We
use a scenario in the exercise in this chapter to practice how to change the stages.

Questions? Visit community.gad.com N QAD
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Master Questions

Master Questions

1 An Opportunity must be associated with a Profile, Contact, and Sales Representative (True or
False?).

2 List the Opportunity Stage values that are predefined in QAD CRM.

d
e

f

3 The Opportunity Reference Field contains the following values:

a
b
c
d

e

ERP Sales Quote Number
User-Defined Value
Blank

ERP Sales Order Number
All of the above.

4 Opportunitiesin the Enquiry Stage can be viewed in QAD CRM (True or False?)

M QAD Questions? Visit community.gad.com
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Wrap-Up

Wrap-Up
Review the Chapter Key Points

Questionse

M QAD

+ Opportunities are business “deals” that are managed from identification until they are turned
into sales orders, lost, or postponed.

- Opportunities are in the Sales Forecast when the Include in Sales Forecast Check Box is
checked on.

« An Opportunity must be associated with a Profile, Contact, and Sales Representative.

+ The Opportunity Stage is arequired field that enforces opportunity management and your
organization’s selling process.

- Opportunitiesthat are in the Quote or Order Stages are sent to QAD ERP and assigned a Sales
Quote Number and a Sales Order Number.

 Quotes can be printed from QAD CRM.

Questions? Visit community.qad.com M QAD
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Exercise

Task 1. Use the following scenario to create an opportunity for an existing customer.

You receive acall from Gene Artuso at Houston Automotive Group. Gene would like to learn
more about the automotive connectors. You promise to send Gene some literature and to call Gene
after Gene has had a chance to review the product literature in more detail. Make sure that you
create a follow-up telephone activity.

1 Navigate to the Houston Automotive Group Profile and select the Opportunity Tab.
2 Right-click in the Opportunity Window and choose Add from the menu.
The Opportunity Details Screen displays. A number of fields are either pre-filled or defaulted Let

us review and update the fields in the Opportunity Record starting with the Details Tab.

Fields flagged with an “*” are pre-filled based on information in the Houston Automotive
Group Profile or the User 1D of theindividual adding the Opportunity.

« *Profile = Houston Automotive Group
« *Contact = Gene Artuso
« *Auto Allocate = Defaults to Your User ID

You can change this field to another Sales Representative by using the look-up or the auto-
allocate button which selects an account manager based on territory allocation.

» Short Description = Automotive connector

The Short Description field can be positioned using the Show Columns feature so you can
easily identify what products are being considered from the Opportunity Browse Screen.

« Type = Automobile Industry
- Source = Customer Inquiry

Enter the Type and Source Fields with the help of the look-ups provided or simply type a
valuein. These fields are primarily for analysis and reporting.

- Reference = leave blank

The Reference Field can be populated by using the look-up, typing in avalue, or system
generated with the ERP Quote Number when an Opportunity is sent to QAD ERP and the
Reference Field is empty. Opportunities are sent to QAD ERP when they Opportunity
Stage has progressed beyond the ENQUIRY Stage.

« Participate in Forecast = Selected by Default

If you do not want the Opportunity to be considered in the Sales Forecast, unselect this
field. There can be times when you want to enter the Opportunity in QAD CRM for easy
tracking but do not want to report on the Opportunity until you have more information.

- Forecast Date = Today's Date
« Due Date = Today's Date + 2 months
 Opportunity ID = System Generated

The Opportunity ID is generated when the Opportunity is saved. The Opportunity Id is
used within QAD CRM and is not integrated with QAD ERP.

» Stage = ENQUIRY
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The Opportunity Stage Field determines where the Opportunity isin the Opportunity
Management Process. Typically an Opportunity follows the path of ENQUIRY, QUOTE,
and ORDER, however, there is no set order. An Opportunity can be entered as an Order.
As previously mentioned, QAD CRM alows you to add custom Opportunity Stages that
match your business process.

- Positioning = Literature Sent
« Next Stage Date = One week from today

It is an approximate date when the opportunity islikely to progressto the next stage.
« Probability = 70%

A sales representative assigns the probability based on the likelihood of translating an
Opportunity into an actual sale. The value in this field acts as aweight on the ENQUIRY
and QUOTE Stages. An accurate Probability ensures a more realistic Forecast. An
exampleis an Opportunity valued at $10,000 with 80% probability has aforecast value of
$8,000.

* Project Probability = 70%

Thevaluein thisfield acts as a separate weighting factor that works cumulatively with the
Probability value and can modify the sales forecast. This field could be used by the Sales
Manager when the Sales Manager thinks the Sales Representative is overly optimistic
about closing the sale.

 Currency = Defaulted to US
- Effective Date = Today's Date
This date is used by the system to calcul ate the exchange rate.
« Calculate Amount = System
By selecting System, the next three fields are populated by the system.
 Currency Stage Amount, Stage Amount, Weighted Forecast Amount
Refer to the QAD CRM User Guide definitions of these fields.
« Description = Opportunity for the automotive connectors

3 Savethe Opportunity.

4 Review the Opportunity from the Detail Tab. Notice that the Stageis set at ENQUIRY and the
Opportunity ID is system generated

5 Select the Activity Tab. Right-click and add the Telephone Follow-up Activity for next week.
Save and review the Activity. The Activity is automatically associated with the Opportunity.
Review the Activity on your Calendar.

Task 2. Use the following scenario to change the opportunity stages.

A week has passed and Gene Artuso at Houston Automotive Group has received and hopefully
read the information you forwarded concerning the automotive connectors. It's time to call Gene.
In this scenario, we access the Telephone Activity that we created and actually record all our work
in the system while processing the activity.
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Navigate to the Telephone Activity in the All View of your CRM Activity Calendar. Right-click
the activity and choose Process from the Menu.

1 Locate phone number of Gene from the Activity. You can record your conversation with Gene
directly into the Opportunity on QAD CRM by opening the Opportunity from the Associate it
with field. Double-Click Automotive connector, which is the Opportunity Short Description.

2 Asyou chat with Gene, Click the Further Detail Tab in the open Opportunity and record the
Strengths and Weaknesses of this opportunity.

3 Youask Geneif Gene hasinvestigated any of the competition. Click the Role Players Tab and
record Gene's answer by entering the Competitor Gene has researched. The Competitor must
be aProfilein QAD CRM. Right-click Competitor and choose Add. Click Select Competitor,
the Profile Search Screen appears. Search for aProfile Type of Competitor. If it does not exist,
add the Profile (Profile Name = ABC Automotive).

4 Geneis explaining the products that Geneisinterested in. Select the Enquiry Tab, right-click,
and choose add to add these Products to the Enquiry.

5 Choose the Automotive Connector product 1D 02001 for 10,000 Units.
6 Click Save & Close to close the Opportunity Lines Details window.
7 Onthe Enquiry tab, right-click and choose Change Opportunity Stage.

8 The Opportunity Change Screen appears with the Stage set to QUOTE and the Preliminary
Radio Button “on”. Select the Opportunity Lines (Products) that you want to copy to the
QUOTE stage and click OK.

QAD CRM noatifies you that the Enquiry Lines are converted to a Quote.

9 Select the Quote tab to see that the automotive connector line is now moved to the QUOTE
Stage of the Opportunity.

10 Select the Details Tab and check the Reference Field. The Reference Field now contains the
ERP Quote Number. When the Opportunity was moved to the QUOTE Stage, it was sent from
QAD CRM to QAD ERP. QAD CRM was updated with the ERP Quote Number.

You can view the Sales Quote in the ERP Sales Quote Browse Screen by searching with the
ERP Quote Number in the Reference Field. You can also view the Sales Quote by using the
Customer Console. We review the Customer Consolein alater chapter.

11 Save the Opportunity Record. You return to the Process Activity Record where you launched
the Opportunity. Update the Telephone Activity with the results of the call.

12 Using the look-up, populate the Outcome Field as Successful and select the Follow-up
Activity in the lower right-hand corner.

13 Savethe Telephone Activity Record. The Telephone Activity is Processed and Closed.
Processed and Closed Activities are displayed with strike-thru text.
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One week later, Gene decided to purchase the automotive connectors and placed an order. What
you are going to do is to change the stage from Quote to Order.

1 From the All Profiles screen, select the Houston Automotive Group profile and go to the
Opportunity tab.

2 Open the automotive connector opportunity and go to the Quote tab.

3 Right-click the record that you want to change the stage and choose Change Opportunity
Stage.
The Opportunity Change Screen appears with the Stage set to ORDER.

4 Select the product line that you want to change to Order stage and click OK.
The system notices you that the sales order has been successfully created in QAD ERP.

5 Select the Details Tab and check the Reference Field. The Reference Field now contains the

ERP Sales Order Number. When the Opportunity was moved to the ORDER Stage, it was sent
from QAD CRM to QAD ERP. QAD CRM was updated with the ERP Sales Order Number.

You can view the Sales Order in the ERP Sales Order Browse Screen by searching with the
ERP Sales Order Number in the Reference Field.

You can continue to change the stages as your company’s process.
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Chapter 7

Reports and Dashboards

This chapter providesinformation of Reports and Dashboards, which help generate the
information you need for making strategic decisions.

Overview

Reporting Functionality

Reports screen

Report Categories

Browser Reports

Formatting a Browser Report
Saving a Browser Report
Running a Saved Browser Report
Sandard Reports

Running Sandard Reports
Filtering Sandard Report Output
Exporting Reports

Dashboard Functionality

Master Questions

Wrap-Up

Exercise
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Overview

Reporis & Dashboards - Overview
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In this chapter, you learn how QAD CRM helps you generate the information you need for making
strategic decisions by reporting and analyzing your customer relationships and business
opportunities.

Learning Objectives

By the end of this chapter, you are able to do the following

L]

MQAD

List the reporting tools availablein QAD CRM.
Explain Report Categories.
Create, run, and save Browser Reports.
List the available Standard Reports.
Run and filter Standard Reports.
Create charts and graphs.
Describe a Dashboard.
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Reporting Functionality

Reporiing Functionality
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QAD CRM users can report on their data using the following:
» Browser Reports
 Delivered Standard Reports
- Export datato defined output channels

Reports screen

The Reports screen displays the saved reports available for your reusein QAD CRM.
You also create reports using the Report Writer tool from the Reports screen.

The Reports screen is available from both Sales Management and Marketing Management. The
Sales Management navigation path is:

Main Menu|Sales Management|Reports

Report Categories

Report Categories allow you to categorize your reports for quick access. There are system pre-
delivered report categories on the Reports scree. Your System Administrator can also define the
report categories.
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Thetraining system has two Report Categories defined - Browser Reports and Standard Reports.
Other common categories include Dashboard Reports, External Reports, or subject categories such
as Customer or Profile Reports.
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Browser Reports

Browser Report
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A browser report provides areport layout of the records displayed in a browser. You can create
browser reportsin the system through any of the data screens, such as Profile browser, Contact
browser, and Opportunity browser.

To access default browser reports, right-click any data screen and choose Report View. The
browser report displaysin the report viewer. You can also format the contents into a more
sophisticated report.

You can modify the settings of the report through the toolbar buttons, then save new instances of a
displayed browser report.

Formatting a Browser Report

A browser report is displayed according to the data in the browser window. You can use the
Show Column feature to rearrange or omit columns from the browser and your report output.

» Oncethedataisin the Report View, you can use the Report View formatting toolbar to format
the report:

Saving a Browser Report

Browser Reports can be saved and rerun. When you save a Browser Report on the Test System,
save the Report to the Browser Category.
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Note Madify the generated browser report before you save it. Otherwise, the Save button is
inactive.

Running a Saved Browser Report

To run a saved browser report:

1 Go to the browser where the saved browser report is generated.

For example, if you want to run a browser report that is created in the Contact Persons
browser, ensure that you are in the Contact Persons browser.

2 Right-click in the browser and choose Report View from the context menu.
A browser report is generated.

3 Onthetoolbar of the new report window, click Browser Report to open the list and choose the
report that you want to run.

4 If the content of the report is not up-to-date, click Refresh button to update it.
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Standard Reports

Standard Reporis
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QAD CRM deliversthe following eight (8) Standard Reports to help you manage your
organization. The names of these reports indicate the nature and scope of the data extract. Standard
Reports display using Crystal Reports and Microsoft Excel depending on the report.

» Activity Summary Report
History Report

Installed Base Report
Opportunity Report by Sales Rep
» Planned Activity Report

Profile Summary Report
Synchronization Status Report

» User Summary Report.

L]

Running Standard Reports

You can run Standard Reports directly from the Reports screen. There are a number of waysto run
areport from the Report Screen. Select the report and do one of the following:

« Click Run thisreport on the toolbar.
« Right-click and choose Run this report.
+ Click File]Run this report.
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Filtering Standard Report Output

QAD CRM alowsyou to filter the output from Standard Reports depending on the report. The
following reports allow you to define filter criteria from the Report Viewer by clicking the Filter
button:

- Activity Summary Report

- History Report

- Planned Activity Report

« Synchronization Status Report

e User Summary Report.
The following reports when run from the Reports screen display afilter window where you define
the selection criteria before the report runs:

« Profile Summary Report

 Opportunity Report by Sales Rep

« Installed Base Report.

Note When QAD CRM isintegrated with QAD ERP, the Profile Summary Report uses data from
both applications and the filter settings display an additional filter called QAD ERP options.
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Exporting Reports

Exporting Reports
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The system allows you to choose the output channel of a selected report through the Export option.
There are multiple ways to export a report:

» Choose Export from the File menu.
« Right-click in the browser and choose Export from the context menu.
« Click Export on the toolbar from the report display.

The Export Wizard prompts you to choose one of the following output channels:
» Application
- Disk File

Microsoft Exchange Folder

- Mail Recipient

* Printers

You can export your data to the following applications from the VTMS (Training) Environment:
» Acrobat Format (.pdf)

Crystal Reports

Internet Explorer - HTML or XML

Microsoft Excel

Microsoft Word - Document or Rich Text

L]
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« WordPad
- Notepad

In this class, we take MS Excel format as an example. To export areport to MS Excel:

1 Form thetoolbar of areport, click Export.
The Export Wizard is displayed.

2 Select Application in the Export to area and click the forward navigation arrow on the bottom-
left corner of the wizard.

3 Onthe Export to Application page, select Microsoft Excel (.xls) and click OK.
4 When the exported report opensin MS Excel, save the .xlIsfile to your desired directory.

If you do not want to preview the report or changing settings for the report before exporting, you
can do the following to export:

- For Browser Report, right-click in the browser where you want to generate areport and choose
Export from the context menu.

- For Standard Report, right-click areport at Sales Management|Reports|Standard Report and
choose Export from the context menu.
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- The Dashboard is a user-defined screen that provides an overall view of your CRM

environment.

- The Dashboard screen can be composed of a maximum of four separate views or components.
« Typicaly a Dashboard is created and maintained by a System Administrator or power user or

reporting specialist.

Navigate to Main Menu|Dashboard and choose My Dashboard from the Dashboard Name. Review
the information displayed in the dashboard.

How to maintain and create Dashboards is covered in the CRM User Guide and in the System

Administrator Training.
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Master Questions

Master Questions

1

Report Categories are used as file drawers or containers to help us organize and access our
saved reports quickly. (True or False?)

When you save a browser report, you can access the report from any record browser in QAD
CRM. (True or False)?

In the Browser View Report, you can remove fields, change fonts, sort and group data, and
create

Name the Standard Report that uses both QAD CRM data and QAD ERP dataiif integrationis
active. )

Name three (3) applications that you can export your data to for reporting:
f

g
h

Dashboards can contain a max of components.
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Wrap-Up

Wrap-Up
Review the Chapter Key Points

Questionse

M QAD

* QAD CRM has a number of reporting tools and options including:
» Browser Reports
 Délivered Standard Reports
» Exporting data to various output channels (including Microsoft Excel and Word)
» Browser Reports are created and launched from record browsers.
 Saved Browser Reports can be accessed from View Report.
- Standard Reports are predefined and use Crystal Reports or Microsoft Excel to display outpui.
» Dashboards are typically created by System Administrators.

« Dashboards can contain up to four components (charts, graphs) and give users aview of their
CRM business - opportunities, forecast, activities, etc.

- Standard Reports use two types of filters, one filter is part of the report viewer and the other
filter must be defined before your run the report.
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Exercise

Task 1. Create a report using a 3-D pie chart that breaks down the number of Customer Profiles
by Country.

1 Navigateto the All Profiles Screen, set filter to No Filter, and right-click to select the Report
View.

2 TheReport View contains alist of All Profilesincluding Suppliers, Customer, and End Users.
You are only interested in Customers.

3 Inthe Report View, select Filter from the Toolbar. Choose Simple Filter. Enter the following
values in the Customer Filter:

- Field = Profile Type
- Condition = Contains
- Value = customer
Click OK to apply the Filter to the report.

4 Choose Graph from the Toolbar to launch the Graph Designer. Select Pie and click the 3-D
Icon for a 3-D Pie Chart.

5 Select the Data Tab and add the Country field to both the On change of box and the Show
Value(s) box.

6 Select the Format Tab and enter a Title for the Pie Chart.

7 Click OK and save the Browser Report as:
« Name = Customer Profile Analysis
« Description = Customer Country Profile Analysis

8 Navigate to the Reports screen and select the Browser Report category.
Note If the Customer Profile Analysis report does not display, fresh the screen (File]Refresh).

Task 2. Run a Profile Summary Report for one of your customers.

Once a quarter, you run a Profile Summary Report for each of your customers. This report gives
you a 360-degree view of all activities for the Profile. Today you want to run a Profile Summary
Report for Houston Automotive Group.

1 Inthe Standard Reports category of the Reports screen, right-click the Profile Summary
Report and click Run this report.

The Profile Summary Report screen displays.

2 Right-click in the profile browser area and choose Attach Profile from the context menu.
The Find Profile/Contact screen displays.

3 Search for the profile of Houston Automotive Group.

4 After add the profile to the report, review the Basic Filter selection criteria on the bottom part
of the Profile Summary Report screen. Clear the following filter options and click OK.
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 User-Defined Fields
» Addresses

« Campaigns
Contracts

Installed Base
 Contract

5 You are prompted to Save the Report Settings so you can rerun the report later. Save the report.

6 Review thereport in the Crystal Report Browser. You can hyper-link to each section of the
report from the left-hand column, print the report, or save the report results.

7  The Profile Summary Report of Houston Automotive Group appears in the Reports screen|
Standard Reports category for later access.
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Advanced Features

This chapter provides information of advanced featuresin QAD CRM and shows how the
concepts introduced in the previous chapters are al used together.

Overview

Profile Relationships
Scripts

ERP / CRM Integration
Customer Console
Master Questions
Wrap-Up

Exercise
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Overview

Advanced Topics - Overview
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* Using Scripts
* ERP/CRM Integration

e Customer Console

This chapter contains a number of QAD CRM advanced features that build on the knowledge
gained earlier in the training.

Learning Objectives

By the end of this chapter, you are able to do the following
« Define Profile Relationships
 Explain and use scripts
 Use the Customer Console
» Explain the ERP/CRM Integration
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Profile Relationships

Profile Relationships
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+ Whatis a Profile Relationship?

+ Adding/Viewing Relationships

Profile Relationships

* Main Menu | Sales Management | Addresses | '

| Hierarchical

The organizations that you do business with can relate to one another in an organizational
hierarchy. For instance, there could be a parent company with many subsidiaries.

Your organization might want to manage all related companies under one account management
structure or at the least understand how the entire customer organizations are doing business with
you.

The Relationship tab on the Profile Record allows you to represent your Profiles Relationships.
You can add, maintain, and delete organizational hierarchies. The Relationship tab allows you to
see all Profiles, Contacts, Opportunities, and Installed Base Records (products installed at the
profile site) for those Profiles that are related.
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Scripts

Scripts

List
= a ivailable Scripts|

= @& Default Section
? What is your store reference / Number?
'? What is pour current method of Waste Disposal?
B How many of these waste containers do you have?
@ How many pickups / collections do you have per week?
? |5 this number of pickups / collections adequate?
? How many waste containers do you use per week?
? Is your rubbish currently loose or compacted?
? Since your waste is curently loose, if a compactor was recommended, would you have room for one? Appn
? Does your current general waste include all your cardboard or do you seperate out cardboard?
= €] LOGIX [Logix - 5 Step Process |
+ @y INITIAL SURVEY
+ & Presentation and Evaluation of Results
+ & DUE DILIGENCE .
+ % Delivery of Process Improvement H ow TO Use S Cri DTS 8
+ % Management Reporting
+ @ Delvery Method How to add a Script

Whatis a Script?

A Scriptisaseries of predefined questions designed to streamline and add consistency to your
communications with your customers.

Typically System Administrators or power users create scripts for use in various departments.

For instance, Customer Service would enter service-related questionsin a script that is used by
customer service representatives to survey the customer base.

Sales can use a script during a new product rel ease to queue sales representatives as to the
important questions to ask a customer. Sales can also find a script useful to query customers on
reorder amounts for certain products that a customer reorders on aregular basis.

Typically the sequence of script-related eventsin your system would occur in the following
sequence:

1 Maintaining your scripts. This step involves tasks such as creating or editing sections,
subsections, questions, and subquestions.

2 Attaching scripts to targets (profile/target combinations).

3 Processing scripts. This step involves contacting the profiles/contacts that are your targets to
capture their responses to your script.

4 Analyzing script responses. This step involves using search criteria to focus on the targets that
responded to your scriptsin away that facilitates your marketing efforts.
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For more information on using scripts, see User Guide: Customer Relationship Management.
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ERP / CRM Integration

ERP/CRM Integration

Settings
= I QADERP Control Settings For Transferring Sales Order infarmation from QAD ERP, (7054)
=/ 17 Q4D ERP Control Setting
&) Users
) Multiple Currency
) Product :
=) Transfer Sales Order Information from QAD ERP to QAD CRM
I Address
7 Sales Quote Transfer QAD ERP Sales Order information to QAD CRM
" [Sales Didef TrarsFer RMA orders to QAD CRM
) Installed Base
- cal [v] Create History
() Call Quote Transfer Transaction Comments from QAD ERP to QAD CRM
] Contract
) Contract Quate Commenk Type: =
=11 Initial Data Transfer from 0 .
= Initial Data Transter from . ) . O verview

) Users
1 Multiple Currency Transfer Sales Order Information from QAD CRM ta QAD ERP

* Integration Points

Gl Prochuct [¥] TransFer QAD CRM Sales Order information to QAD ERP
) Address
7] Sales Quate [¥] Create customer in QAD ERP if QAD CRM sales order customer not Found
1 Sales Order " S
) Installed Base Service name: | live_AS :J
i1 Call {CIM scripk file: | [fdr01/scripts client_cim_linue. s
'_—-I‘ CalQurts User: admin
=1 Conlract
Password:  ees

I7) Contract Quate

QAD CRM runsin stand-alone mode as a CRM Application or can be integrated with QAD ERP
applications.

Your System Administrator sets up thisintegration according to your business rules and processes.
For instance, your organization might want to restrict the flow of datafrom QAD CRM to QAD
ERP for certain processes.

Onceintegration is defined and set up, the data synchronization is automatic. Database and session
triggers update the data.

In the Training Environment, you are prompted whether you want to send this Profile to QAD
ERP. However, when you change the Opportunity stage from Enquiry to Quote, the Quoteis
automatically sent to QAD ERP.
The following modules can be integrated:
« Product
» Address
Sales Quote
 Sales Order
Installed Base
- Cdl
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« Contract

Contract Quote
Call Quote
Multiple Currency

o Users

Asasales or an account manager, you would not set up thisintegration, but you want to accessthe
datain QAD ERP sometimes.

In the followed Customer Console, we introduce how you can easily toggle and share information
between QAD ERP and QAD CRM.
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Customer Console

Customer Console

Customer Console

Number Name Addressi Addressz Address3

Addresses ¥ 01000000  Cobossal ConglomeratesLTD | Sida 1000 Colncenl iy Colossal Industril Park 15000 Products
Sales Quate ¥ GoTo » | ncticty
Sales Order £ | GoToQaoERP | Seles Quote
order _vse A Refromn Saes Order
S - EE
2L sart o
ignore v ===
S - a Record Count ::t::isa”
Is {exactly) il Repork View :
Quote _ Export R
is (exactly) | Ty Search C =
Fresform query
.:. A .. ..Dﬂ V_l Sales History
] Statistic
ship-To
End User
Position Department Mail greups
Invoice 3.
L. Main Menu | Customer Console

The Customer Console uses data from both QAD ERP and QAD CRM. This application or
modul e provides a 360-degree view of your customer when QAD ERP integration is enabled.

The Customer Console Screen is designed and operates like the Search a Profile or Contact
Screen.

The Customer Console searches QAD ERP based on your input and returns the appropriate data.
You can also use the options of Go To QAD ERP or Go To a particular screenin QAD ERP, such
asthe Sales Order or Sales Quote screen.

Note To usethe Go To options, ensure that you have access to QAD ERP and that QAD ERP
integration is enabled.
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Master Questions

Master Questions

1 Youdo not need alogin to QAD ERP when you Go To QAD ERP from QAD CRM. (True or
False?)

2 Scripts are considered activitiesin QAD CRM. (True or False?)
3 Thelist theinformation shared among Profiles that have relationships defined:

j
k

4 The Customer Number in the Profile is updated when the Profile is added to QAD ERP. (True
or False?)

5 Theintegration between QAD CRM and ERP is enabled on demand from QAD CRM. (True
or False?)
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Wrap-Up

Wrap-Up
Review the Chapter Key Points

Questionse

M QAD

- Profile Relationships are set up in hierarchies and show the relationships between customers.

 You can add hierarchies to arelationship or you can attach existing hierarchiesto a
relationship.

» Once aProfile Relationship is set up, all Profiles in the relationship share the following data:
Profiles, Contacts, Opportunities, and Installed Base from the Relationship Tab.

« All roles can sue scripts in your organization - sales, marketing, customer service, etc.
« Scripts are a series of questions when processed record the answersin QAD CRM.

« Scripts can be attached to atarget (Profile/Contact) from the Script Tab or they can be added
as an Activity.

» The Customer Console allows you to easily verify and share information between QAD CRM
and QAD ERP.
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Exercise

Use the following scenario to set up profile relationship.

Your customer Houston Automotive Group has purchased the following organizations that you do
business with:

« ABC Automotive
« Auto-Plas Internationa

You have also learned that Autoliv France SNC is a spin-off of the ABC Automotive.
Let us set up these relationships!
1 Navigateto the Profile for Houston Automotive Group. Select the Relationships Tab.

2 Right-click Hierarchal Relationships and Add Hierarchy. Name the Hierarchy: Parent-
Houston Automotive Group.

3 Right-click in the Relationships Profile Tab and add the Profile Houston Automotive Group.

4 Review the following Houston Automotive Group information:
 Opportunities tab
- Relationship Opportunity tab
- Relationship Contact tab

Note Theinformation contained in the Houston Automotive Group record is also displayed in the
appropriate tab under Relationships.

5 ABC Automotive and Auto-Plas International are both companies that report to Houston
Automotive Group. Right-click the Parent-Houston Automotive Group and Add a Sub-
Hierarchy named Sub-ABC Automotive.

6 High-light Sub-ABC Automotive in the Hierarchal Relationships and attach the Profile in the
Relationship Profile tab.

7 Repeat for Auto-Plas International. Make sure that they are both equal “subs’ in the Hierarchy.

8 Auto-Plas International isthe “parent” company of Autoliv France SNC. Right-click Sub-
Auto-Plas International and add Autoliv France SNC.

9 Navigate to any of the Profilesin the hierarchy and check the Relationship tab. Check and
uncheck the Include Sub Hierarchies box at the bottom of the screen - what data do you see?
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Product Information Resources

QAD offers anumber of online resources to help you get more information about using QAD
products.

QAD Forums (community.gad.com)
Ask questions and share information with other members of the user community, including
QAD experts.

QAD Knowledgebase (knowledgebase.qad.com)*
Search for answers, tips, or solutions related to any QAD product or topic.

QAD Document Library (www.gad.com/documentlibrary)

Get browser-based access to user guides, release notes, training guides, and so on; use
powerful search features to find the document you want, then read online, or download and
print PDF.

QAD Learning Center (learning.gad.com)*
Visit QAD’s one-stop destination for al courses and training materials.

*Log-in required


http://community.qad.com
http://knowledgebase.qad.com
http://www.qad.com/documentlibrary
http://learning.qad.com
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